
Remote Sensing, Fall 2022 

Lab 6:  Feature Extraction 
 

Lab goals  

Satellite images like air photos can be used for manual interpretation, but because they are 

digital, we can use image processing techniques to semi-automatically extract vector features. 

The specific goal in this week's lab is to create vectors for 2-3 class features which you can 

clearly identify and reduce to a manageable number of polygons.  

There are five main steps: 

• Generate a clean layer containing the desired features –a bitmap or raster channel from 

THR or Ratio-Index-Transform or Classification 

• SIEVE to create a manageable number (sieve works only on raster channels) 

• Generate vectors (raster to vector) –RAS2POLY or  BIT2POLY or EXPOLRAS 

• Smooth vectors – SMBOYLE or SMMCMASTER 

• Examine and clean attribute table  - calculate area stats (in Catalyst or GIS) 

Features to extract:  

• 1. Water   

• 2. A vegetation land cover class 

 

1. Set-up  
 

Copy bowron19aug2016.pix     from L:\GEOG357 

Start Catalyst and open your copy of bowron19aug2016.pix      

Change display to 654 and enhance (note: this is Landsat 8 = 16 bit data) 

 

2. Extract water from the 2016 multispectral image 

We’ll first create the water bitmap like you created in lab2 to generate a vector shapefile for 

water: rivers and lakes. We can then convert this to a vector layer  
 

 A. Create a bitmap for water, same method as you did for PG water in lab 2 (THR).  

As water does not reflect IR, we use the NIR band to find the threshold value that separates 

water, though you will have DNs that conflict with shadows – just as in PG, but maybe worse. 

Note that we’ll try to solve this in the next lab.  The maximum value for water is just over 7000, 

maybe 7100. In the THR menu, set the raster band to 5 (NIR) and output to Viewer. Threshold 

Maximum is 7100 or whatever you decide, and minimum can be 0. 



Inevitably you will grab some shadow as well, but it’s easier to remove that later, than to go low 

and miss more water. Once you are satisfied, change output to your .pix file instead of viewer 

and run. This will create a bitmap layer in the file. You want everything in this one .pix file. 

 

B. EASI modeling to improve water layer 

We can reduce the shadow problem when we consider that water is wetter than shadowed rock, 

and therefore has lower DN values in the SWIR band (6). Highlight the colour composite so that 

the DNs at bottom show RGB instead of the bitmap or another layer. 

Click in the shadows and on the water to see typical DNs in Band 6 (Red Gun). Not perfect but I 

estimate an approximate boundary at 6200 between water and shadow. 

 

We can add this condition to our identification of water  

i.e. Band 5 < 7100 AND Band 6 < 6200 

 

To do this, we need to: 

1.Create a new empty bitmap to take the result 

Switch from map to files tab 

Right-click on the filename  -> new -> bitmap layer   

it will give you the new bitmap number which should be 3, your water layer was bitmap 2 

 

2.tools->  EASI modeling 

In the pop-up box type these lines below: note that a bitmap is coded %% and a band =% 

 

if %%2=1 AND  %6<6200 then 

%%3 =1 

Endif             - then click on ‘Run’ 

 

This says that if for any pixel bitmap 2 has a water AND Band 6 DN is less than 6200, then that 

pixel is accepted as water in the new bitmap 3 (otherwise it’s not) –  

Note the most common errors in EASI modelling is to forget to add ‘then’ and ‘Endif’ 

 

You can also save this script for future use .. click on save, and you can name it e.g. water. It will 

save a file named water,eas in your folder. You can ‘load’ it again to re-use and not retype. 

 

But nothing has appeared on screen, as you need to add bitmap 3 to the display: 

Layer -> Add -> bitmap  (and select 3) 

You should find it has only reduced the number of shadow pixels but it will do for now. 

 



3. Vectorise the bitmap to create water outlines: BITPOLY 

 
tools-> algorithm library → BIT2POLY 
Input: the bitmap layer number (3) 
Output: viewer  
Params: smooth should be checked        RUN 
 

If you can’t see your new vector lines e.g. if they are blue, right-click on the new polygon layer 

in the display listing and change the colour 
 

Now uncheck the smooth vectors box in parameters and run again, output to the viewer, AND to 

your pix file.  Compare the result with the smoothed version to see the effect of the 

smoothing algorithm … 
Zoom in A LOT to view the difference – the ‘staircase’ of pixels has been reduced, not removed 

 
You now have two new vector layers, one smoothed (onscreen only), one not smoothed/saved. 

 

We will use a more sophisticated algorithm to smooth the unsmoothed version, written by Ray 

Boyle, U. Saskatchewan. It is called SMBOYLE and is found in the Algorithm Library. 

 

 Input your unsmoothed vector layer, output to viewer and the 2016 pix file. 
You should find this is a better result - NOT smoothed in BIT2POLY but smoothed by 

SMBOYLE. The one smoothed only in BIT2POLY is not as rounded. 

 

Q1: Catalyst also has a BIT2LINE option – give two examples where you might choose to use 

this option instead of BIT2POLY to extract suitable features and under what circumstances.. 

 
4. polygon attribute tables 
 

You can’t sieve a bitmap to remove wee bits, only a raster, but we can remove small polygons 

either in GIS or Catalyst:  right-click on the polygon layer label and pick Attribute Manager 

The areas may be in square metres as default with UTM coordinates, and if so we can convert to 

hectares or square kilometres to reduce ‘scientific notation’.  
 

Right-click on the Area column heading, select Table definition, change decimal places to 4 and 

display units to Kilometres.      Apply     OK 

Deselect Area heading – click on it 

 

Now we can remove small polygons the ‘GIS way’. 



Select the Record dropdown, then query by -> example 

 

Edit the statement to read:  Area < 0.01            (=1 hectare or .01 km2) 

You MUST edit using the menu provided, not your keyboard –  

Use the operator button and click on ‘entire list’ to display all values 

– if there isn't an exact 1 hectare value, click on the nearest value (e.g. just above .01) 

Click on Insert         Apply        OK 

 

Now all records are gray highlighted if Area < 0.01 km 

Right-click on one that is selected in the left column and pick delete – deletes all the small ones 

You have deleted all the wee polygons smaller than 12 pixels / 1 hectare 

 

Layer-> Save as ,       pick your 2016 pix file and the Polygon Layer 

 

Layer-save as again and this time scan down a few lines to the ArcGIS shapefile, and save as 

shapefile .. you could name it something like water2012.shp and save in your folder. This can be 

directly opened in ArcGIS or QGIS – unlike the layer stored in the .pix file. 
 

Click again in the top left column (blank to the left of 'ShapeID', and you should see a summary 

of stats for the water polygons, including total area (sum) for the polygons.  

 

Q2: a. how many water bodies are in this layer and what is their total area (km2) 

b. What is the area of each of the two largest lakes (km2) ? 

 

5. Polygon layer for another land cover class - EXPOLRAS 

The EXPOLRAS algorithm goes beyond BIT2POLY with multiple steps to extract and refine 

features by thresholding, sieving and vectorizing in one operation. 
 
First we need a layer to work with – it might be a classification, but we’ll settle for the NDVI for 

this area, and try to extract Avalanche slopes. These are not as easy to extract as water - 

nothing is ! One can assume they mostly have the highest DN values in the NDVI layer.  
 

Use the Raster calculator to create  NDVI: (NIR-Red)/(NIR+Red) .. insert band numbers 

Remember to write this to a 32-bit channel and as a new layer in your 2016 pix file 

Query the DNs in this layer on the avalanche slopes – I found a value of 0.38 was a good 

minimum, while we don’t need a maximum as we assume these are the highest values. 

 



Tools → Algorithm Librarian -> EXPOLRAS 
Input: your NDVI channel 
Output: to viewer and your 2016 pix file 
Params: 
Threshold Minimum 0.38  
Minimum Area:  12 – this is the sieve operation (which may be redundant if done before) 

Go to log tab and Run … it should be successful 

You now have a polygon layer for avalanche slopes– you don’t need to remove small polygons 

as the minimum did this, though you may still find some small ‘donut holes’ of non-

deciduous in the avalanche slopes etc.. However the high values will also catch many of 

the regenerating cutblocks. We could use the Bowron lakes park boundary polygon to 

remove these with a ‘clip’ as there are no cutblocks inside the park – it is a park ! 
 

Smoothing – run SMBOYLE and output to Viewer and your .pix file 

 

Q3a: how many smoothing routines are in the Algorithm Library ? (all begin with ‘SM’) 

b. Which one does Catalyst recommend for converted raster data and why  

(Note that I am biased as Ray Boyle is Canadian and I met him at U.Sask) 

 
Right-click on the polygon label in the 'maps' tab and open the Attribute manager.  
convert units to square hectares, and review the total. Save the polygons as a layer in the pix file 

and also save the vector segment also to a shapefile (e.g. avslope.shp) 
 
Add the Bowron Lakes Park boundary shapefile: 

Layer-> add-> vector and browse to /home/labs/geog357/shapefiles/bowron-utm.shp 
[remember to do the final click on the VEC link in the bottom window] 
Once loaded to view, right-click and also save it to your own folder 
 

You can see all cutblocks are neatly outside the Park – of course, it is a park ! 

We could clip our avalanche slopes to just get the ones inside the park (see graphic) 

 
CLIP: Catalyst clips rasters but not vectors, so you would better do this in ArcGIS or QGIS. Are 

you able to do this – let me know if not. Note that you will first need to ‘repair geometry’ 

(ArcGIS) or‘fix geometry’(QGIS) in the avalanche slopes shapefile, before you can clip. 

 
Q4: what is the area of avalanche slopes inside the park 

(accepting our image misses some parts of the park in the north 

and southeast). Please give the answer in a. hectares and b. 

kilometres. 

 

 

 



 

6. Filters; EDGE and FSHARP 
 

Tools-Algorithm Librarian and Find EDGE 

Input your NDVI channel 

Output (Magnitude): Viewer-Grayscale 

Output- Gradient direction: None (tick off any default) 

Log tab and run 

Ensure your NDVI layer is also in the maps display list and ‘flicker’ between that channel and 

this new layer created by EDGE. 

 

Tools-Algorithm Librarian and Find FSHARP 

Input your NDVI channel 

Output: Viewer-Grayscale 

Log tab and run 

Ensure your NDVI layer is also in the maps display list and ‘flicker’ between that channel and 

this new layer created by FSHARP. 

 

Q5a: describe the difference in result between EDGE and FSHARP 

5b. EDGE almost seems to have identified all lake edges; what are the typical high DN values in 

the EDGE layer for these ? 

 

Send answers to:  wheate@unbc.ca  by Friday 10pm 

 

 

 

Repeat of all questions: 

 

Q1: Catalyst also has a BIT2LINE option – give two examples where you might choose to use 

this option instead of BIT2POLY to extract suitable features and under what circumstances.. 

 

Q2: a. how many water bodies are in this layer and what is their total area (km2) 

b. What is the area of each of the two largest lakes (km2) ? 

 

Q3a: how many smoothing routines are in the Algorithm Library ? (all begin with ‘SM’) 

b. Which one does Catalyst recommend for converted raster data and why  

(Note that I am biased as Ray Boyle is Canadian and I met him at U.Sask) 

 

Q4: what is the area of avalanche slopes inside the park (accepting our image misses some parts 

of the park in the north and southeast). Please give the answer in a. hectares and b. kilometres. 

 

Q5a: describe the difference in result between EDGE and FSHARP 

5b. EDGE almost seems to have identified all lake edges; what are the typical high DN values in 

the EDGE layer for these ? 

 

mailto:wheate@unbc.ca

